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Introduction

The Pentaho BI Platform is a Web-based framework that leverages elements of Pentaho Analysis and Pentaho
Reporting to provide easy-to-use tools for creating and sharing Pentaho Analyzer reports, ad hoc reports, and
dashboards. It is the heart of the BI Suite, which also includes powerful software to prepare your data and create
detailed reports.

The BI Platform Enterprise Edition includes two graphical user interfaces: The Pentaho User Console, which helps you
discover patterns, trends, and other hidden information about your data; and the Pentaho Enterprise Console, which
gives sysadmins, IT managers, CIOs, and database administrators fine-grained control over every aspect of BI Platform
configuration, management, and security.

The purpose of this guide is to teach business users how to use the Pentaho User Console. The instructions below
assume that the BI Platform has been properly configured for users, roles, and data sources through the Pentaho
Enterprise Console.
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First Steps

Your system administrator, IT manager, or supervisor should have provided you with a Web address and login
credentials for the Pentaho User Console. If not, now is the time to inquire about them.

How to Log Into the Pentaho User Console
Follow these steps to log into the Pentaho User Console:

1. Open a Web browser and type in the address of the Pentaho server.

You'll see an introductory screen with a Login button in the middle.

2. Click Login.

A login-related pop-up appears.

3. Type your user name and password in the appropriate fields and click Login.

You are now logged into the Pentaho User Console, and ready to start creating and running reports and Pentaho
Analyzer reports.

Navigating the Pentaho User Console
The Pentaho User Console was designed to be intuitive to users accustomed to standard file managers like Windows
Explorer, and Web browsers like Firefox.

The first thing you will see when logging in is the quick launch, shown below:
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Note:  If you do not have a Pentaho Dashboards Enterprise Edition entitlement, the New Dashboard button will
instead be Manage Content, which will open a dialog box that offers quick availability to the edit, share, and
schedule functions for existing content.

Click one of the three icons in the center of the screen to create a new ad hoc report, Pentaho Analyzer report, or
dashboard.

The button bar near the top of the page also contains icons for starting new ad hoc reports, Pentaho Analyzer reports,
and dashboards, along with a button to print the current report or Pentaho Analyzer report, and to open a previously
saved solution.

The menu above the button bar performs these same functions, plus administrative actions if you are logged in as an
administrator, and also offers access to My Workspace and external links to help and support resources.

The three buttons on the quick launch page appear when you log onto the Pentaho User Console for the first time, and
when you close all tabs in the solution browser.

You can change views between My Workspace and the solution browser at any time by clicking the rightmost icons in
the top button bar, or through the View menu.

The navigation pane on the left allows you to browse through your existing solution folders. Solutions are content files
such as dashboards and reports inside the folder. You can create and delete solution folders by right-clicking inside
the navigation pane. You can also examine information associated with solution folder contents by right-clicking and
selecting Properties.

Creating a New Solution Folder

Follow the instructions below to create a new solution folder in which to save solution (content) files such as
dashboards, ad hoc, and analyzer reports.

1.
Click  (Toggle Browser) so that you can see navigation pane (Browse) on the left.

2. Scroll down to the end of the list of solution folders and right-click to display the New Folder dialog box.

Note:  If you want to create a sub-folder inside an existing solution folder, right-click on the existing folder and
select New Folder.

3. In the New Folder dialog box, type a name for your folder and click OK.

Note:  The repository is refreshed. This action may take a moment.
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The new folder appears in the navigation pane.

Deleting a Solution Folder

Follow the instructions below to delete a solution folder.

1.
Click  (Toggle Browser) so that you can see navigation pane (Browse) on the left.

2. Scroll down to the solution folder you want to delete, right-click, and select Delete.
You will be asked to confirm your delete request.

3. Click OK.

Note:  The repository is refreshed. This action may take a moment.

The folder disappears from the navigation pane.

Using My Workspace

My Workspace is a graphical overview of the reports and Pentaho Analyzer reports you've created and scheduled. Click
the triangle on the left side of each category to see the elements it contains.

Reports that you've created or have access to will have options to the right of each report listing to suspend or run
them, and schedules have options to suspend, run, or delete them.

Waiting

This category lists all private schedules that will run in the future. Clicking Cancel will delete the schedule. If you want to
suspend a schedule, you should use the Suspend function of the My Schedules list instead.

Complete

Each report that has been run via a schedule will show up in this list. Every time the schedule executes, it overwrites
that report's previous entry in the Complete list.

My Schedules

This category contains a comprehensive list of your private schedules, including those that are not currently waiting to
run. This will be identical to your Waiting list unless you have suspended any of your schedules.

All Schedules

This is a combined list of public and private schedules under your control. It is only viewable by administrator-level
users.

Public Schedules

This is a list of all public schedules set by the administrator from the Pentaho Enterprise Console. You can run a public
schedule manually, but you cannot change its interval through the Pentaho User Console.
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Working With Ad Hoc Reports

The procedures below explain everything you need to know about working with ad hoc reports in the Pentaho User
Console.

Note:  The ordering of all of the list elements in the ad hoc reporting interface is determined by the data source's
metadata, which is created and modified through Pentaho Metadata Editor.

Creating An Ad Hoc Report
Pentaho Report Designer is the most comprehensive report design tool in the Pentaho BI Suite Enterprise Edition, but
for preliminary report exploration or to generate a report quickly use the ad hoc report wizard built into the platform. Ad
hoc reporting helps you quickly identify and group interesting and relevant data, apply constraints to it, and generate a
report. The resulting reports are viewable through the built-in preview feature; through a Pentaho Reporting-based Web
application; or as a standalone PDF, XLS, CSV, or HTML file. To create an ad hoc report, follow these steps:

1. In the File menu, select the New sub-menu, then click Report.

The ad hoc reporting wizard appears in a new solution browser tab.

2. In the first step of the wizard, select a Data Source. The  Details table will populate with available tables and
columns.

Data Sources are defined by your administrator.

3. In the Apply a Template field, select a predefined report template. A thumbnail preview of the template will appear
in the Template Details field.

A template specifies a variety of properties in the report that affect its appearance, like font size and background
colors for various report elements.

4. Click Next.

5. In the Available Items list, select the business columns that you want to see in your report, and click and drag them
to the Groups, Details, or Filters lists on the right. You must have at least one business column in the Details list for
a report to be valid.

You can select multiple items by holding down the Ctrl key. If you want to delete an item, click the X in the upper
right corner of the field the item is in; if you need to move an item up or down in the list or to other groups, click the
up or down arrows at the top of the Groups list.

6. In the Preview as drop-down box, select a preview format, then click Go. When the preview appears in a new
browser window or tab, verify that it contains the data you selected and that it's presented appropriately.

7. Click Next when you're ready to start refining your report.

8. Click the Level 1 item in the Groups list. The General options list will appear on the right.

9. Modify the level options to your preference.

By default, the Show Group Summary checkbox is selected; uncheck it if you do not want to see group summary
information. The default name for the group summary uses the group name as a variable; you can change this if
you like. The options in the Formatting lists determine where in the report the information in the selected level will
appear.

10.Repeat the above two procedures for other levels that you configured earlier.

11.Click the first item in the Details field. Three new options lists will appear on the right.

12.In the Formatting field, select the numerical formatting and alignment options appropriate for your situation.

13.In the Calculation list, select the function you want to use to refine the element you selected. For instance if you
selected a Business Column that contains product prices, clicking on Sum would add all of the prices together.

14.Click Add a Constraint. The field will expand to show the name of the element, a conditional drop-down box, a text
field, and a checkbox.

15.Select a conditional symbol from the drop-down box, then type in a value in the text box.

This specifies the exact constraint you are applying to the element, meaning that you are decreasing the amount of
detail by adding a higher level of specificity.

16.Add further constraints as necessary by clicking Add a Constraint again. Remove a constraint by clicking its
checkbox and then clicking the X at the top of the list.
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If there is more than one constraint in the list, you will have the option of adding conditional operators for the
constraints via a drop-down box to the left of each item in the list, meaning you can specify AND or OR conditionals
on each constraint.

17.In the Sort Columns field, click Add to specify how each element in the Details list should be sorted, then select the
sort order from the drop-down box.

18.Repeat the above steps for any other items in the Details list.

19.Click the first item in the Filters list. The Constraints list will appear on the right.

20.Add constraints as necessary, per the above instructions for adding constraints to items in the Filters list.

For string-type Business Columns, you will have the option of searching the database tables that apply to the
column. When this option is available, it is accessible via a magnifying glass icon to the right of the text box.

21.Repeat the above instructions for additional filters.

22.Click Next to move on to the next screen.

23.To set the header, footer, description, paper type, and page orientation, change the values accordingly.

PDF is the only output type that has a concept of a page, so the Page portion of the Header and Footer sections
only applies to PDFs.

24.Click either the Save or Save As button to save your report, or select Save from the File menu. In the ensuing
file dialog, navigate to the location you want to save the report to, type in a filename for the report, and click the
checkboxes next to the file formats you want to save in.

You can continue to modify your report after it's been saved; just click the Save button to update the saved report
after you've made changes.

Note:  The Save dialog does not list output types; instead, it pulls the currently selected preview output type.
By default that is HTML, so that will also be the default format to save as. If you want to save as a different
output type, select it from the Preview drop-down list before saving.

You now have a complete ad hoc report in the format or formats you specified.

Editing an Existing Report
After you've created and saved a report, you can go back to it later and change its properties.

1. In the upper left pane, navigate to the location of your report. It should appear in the lower left list when you've
selected the proper directory.

2. In the lower left pane, right-click the report you want to edit, then click Edit in the popup menu.

The ad hoc report wizard will open in a new tab.

Deleting a Report
After you've created and saved a report, you can delete it using the Explorer-like Pentaho User Console file browser.

1. In the left pane, navigate to the location of your report. It should appear in the lower left list when you've selected the
proper directory.

2. Right-click the report you want to eliminate, then click Delete in the popup menu.

The selected report will be removed from your computer. Any associated artifacts will not be removed, so some manual
cleanup may be required if you want to remove more than just the report.

Running a Report
After you've created and saved a report, you can execute it manually at any time.

1. In the left pane, navigate to the location of your report. It should appear in the lower left list when you've selected the
proper directory.

2. Right-click the report you want to run, then click Run in the context menu.

You can alternatively double-click on a report to run it.
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3. In the Run sub-menu, select one of the following options: New Tab, New Browser Window, or Background.

The options will open the report in a new tab, a new browser window (which may open in a new browser tab,
depending on which Web browser you are using and how it is configured), or it will run in the background and inform
you when the report is ready to view. The popup dialogue that informs you of the report's completion will ask you if
and where you would like to display it.

The selected report will be executed, and display according to the option you selected.
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Creating a New Analyzer Report

Pentaho Analyzer reports are similar to standard reports, except that they are designed to be completely interactive
and dynamic. Unlike standard reports which tend to be static or minimally interactive after they are created, Pentaho
Analyzer reports allow you to explore your data dynamically and to drill down into the data to discover previously hidden
details.

In this exercise, you will be creating a report that displays the actual versus budgeted expenses by region for each
department in the fictitious Steel Wheels company (SampleData).

Follow the instructions below to start creating the Analyzer report.

1. In the Pentaho User Console menubar, go to File -> New and select Analyzer Report.
Pentaho Analyzer opens.

2. Select your Schema and Cube from the corresponding lists. For the purposes of this exercise, select SampleData
and Quadrant Analysis, respectively.

Note:  The list of available schemas and cubes are provided by your administrator. A schema is the structure
of the relational database and includes tables, fields, views, and more. A cube is a data structure that allows
information in a database to be analyzed quickly and from multiple perspectives.

3. In the list of fields, click and drag Department to the Analyzer workspace in the left pane.
The Department column appears in the workspace.

4. In the list of fields (on the right), click and drag Department to the Analyzer workspace in the left pane.
The Department column appears in the workspace.

5. Right-click the Budget column to display the Edit Column dialog box. Select Column Name and Format ->
Currency ($) from the Format list so that your values display as dollar amounts. Repeat this step for the Actual
column.

6. Click and drag the Region column to the report. (Read the note below.)

Note:  Notice that the Region column appears in the workspace; however, you want this column to be the
first column in the report.

7. In the workspace, click and drag the Region column to the left of the Department column.

Pentaho Analyzer is designed to provide you with great flexibility when designing the visual structure of your report.

8. At this point you have a functioning report and you can view your data in chart form. Click  (Switch to Chart
Format) to examine your report data in a chart format. The default display is a bar chart but if you click  (Choose
Chart Type) you can select a different chart type to display your data.

9. Save your report before continuing the exercise. In the Pentaho User Console, click (Save As). When the Save
As dialog box appears, save your report as Regional Expense Report under /steel wheels/analysis and
click OK.
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Simple Conditional Formatting of Measures
Conditional formatting in the Analyzer data grid means that cells will be physically affected by the data they contain.
The most common form of conditional formatting is stoplight reporting, where cell backgrounds are colored red, green,
or yellow depending on user-defined thresholds. Analyzer offers some simple pre-defined methods of conditionally
formatting numeric data. Follow the directions below to implement conditional cell formatting.

1. Right-click a measure in the grid, then select Conditional Formatting from the context menu.

A sub-menu with conditional formatting types will appear.

2. Select your preferred number format from the list.

Consult Conditional Formatting Types on page 13 for more information on simple conditional formatting types.

The analyzer report will refresh and apply the formatting choice you specified.

Conditional Formatting Types

Indicator Type Description
Color scale The background cell color will be

shaded according to the value of the
cell relative to the highest and lowest
recorded values in that measure.
There are several color progressions to
choose from.

Data bar The cell background is partially filled
with a solid color proportional to the
scale of the cell's value relative to the
highest and lowest recorded values in
that measure.

Trend arrow An upward or downward arrow is
displayed to the right of the cell value
depending on whether it is above or
below the median value of the selected
measure.

Enhancing the Pentaho Analyzer Report
You have created a working Analyzer report; however you can make the data in the report more useful if you can show
the difference, in dollar amounts, between the actual and budgeted expenses.

Follow the instructions below to enhance your report.

1. In the Pentaho User Console menubar, go to File -> Open.

2. Browse to /steel wheels/analysis and select Regional Expense Report.

3. Click  (Switch to Table Format) if you are in chart mode when the report appears.

4. Right-click the Actual column and select User Defined Number -> Calculated Number.
The New Calculated Number dialog box appears.

5. In the Name field, type Difference.

This step creates a new column in the report.

6. Select Currency ($) from the Format list so that the data in your report displays as dollar amounts.

7. In the right pane of the dialog box, click  so that a minus sign appears next to [Actual]-.

8. Click Budget in the left pane and click  to move it to the right pane so that you create a formula that subtracts the
budgeted expenses from the actual expenses, [Actual]-[Budget]. Click OK.
The Difference column appears in the report.

9. Right-click the Region column and select Show Subtotals.
The subtotals for each region is displayed in the report.
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10.Save the report.

Adding Filters to an Analyzer Report
Filters are used to restrict or limit the data that is presented in a report. For example, a report shows sales by product
line. A filter on Quarter restricts the data so that sales for the fourth quarter in 2006 only are shown. If you were to
add a regional filter of Europe, the report displays data pertaining to European sales in the fourth quarter of 2006,
exclusively. If you were to add a filter on the Product Line field to exclude Surfing, the report displays data pertaining
to European sales in the fourth quarter of 2006 that are not in the surfing product line, exclusively.

Follow the steps below to add a filter to your sample report:

1. Open the Regional Expense Report.

2. Under the report name click Show/Hide Filters next to No Filter in Use.
A workspace for filters appears at the top of the report.

3. Click and drag the Region field/column into the filter workspace.
The Filter on Region dialog box appears. Notice that the values, (Central, Eastern, Southern, and Western),
associated with the Region field are listed in the dialog box. You can choose one of these values or you can enable
Match a specific string to filter the report on a specific string of data.

4. Select Eastern from the list of values and click  (Add Selected) to move it into the right pane.
Eastern appears with a green checkmark next to it in the right pane.

5. Select Western from the list of values and click  (Add Selected) to move it into the right pane.
Western appears with a green checkmark next to it in the right pane.

6. Click OK to exit the dialog box.
Your sample report displays data for the Eastern and Western regions only.

7. Click Undo or Reset to to go back to the previous version of the report.

Adding Query Parameters to Analyzer Reports
You must be logged into the Pentaho User Console, and have an Analyzer report open for editing in order to continue.

Follow the below procedure to parameterize your MDX query in Analyzer.

1. Right-click on the dimension member you want to create a parameter for, and select Filter from the context menu.

2. Select the level you want to set as the default parameter value, then click the right arrow to move it to the list on the
right.

3. Click the checkbox at the bottom of the window, then type in a name for the parameter in the Parameter Name field.

4. Click OK.

Your parameter is now created as a filter in Pentaho Analyzer. Whenever this Analyzer report is run, users will have a
selection of columns to filter by.

Note:  If you create a dashboard with this Analyzer report, then this filter can be used by Dashboard Designer as
a parameter as well.

Exporting the Analyzer Report
Pentaho Analyzer allows you to export your report as a PDF, a Microsoft Excel spreadsheet, or a CSV file.

Follow the instructions below to export your report:

1. In the Pentaho Analyzer toolbar, click More and select Export Report.
The export options list appears.

2. Select Export to PDF.
A PDF of the report appears.

3. Examine your report.
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Notice that Pentaho Analyzer appends metadata about the report itself in the PDF. Information about the report
author, the location of the source file, fields used, filter summary, are included.

Filtering by Member Properties
If a dimension has a number in parenthesis next to it in the field list, that means that it has member properties
associated with it. To constrain a dimension by controlling its member properties, follow the instructions below.

1. Open the field layout by clicking Show Field Layout button above the grid.

Depending on how you have them oriented, you will see your selected dimensions in either the Row Labels or Col
Headers fields.

2. Right-click on a dimension in the row label or column header fields, then select Show Properties from the context
menu.

A sub-menu with all available member properties will appear.

3. Check or un-check the member property boxes to add or remove them from the report, then click OK.

The analyzer report will refresh and show the filter choices you've selected.

Configuring Drill-Down Links
To create reports based on specific number value data, you can implement drill-down links in Pentaho Analyzer. This
will turn all non-calculated number fields into links which, when clicked, bring up a configurable data grid that enables
you to quickly view more details for that data point without having to reconfigure your report. Follow the directions below
to turn on drill-linking.

Note:  Calculated members are unavailable for drill-down at this time.

Note:  Drill-down links will not work in reports that have filters that are not being used. If you have any filters in
an Analyzer report, they must be used in the report in order to view drill-down links.

1. Open the Analyzer report that you want to add drill links to.

2. Go to the More menu in the upper right corner of the report, and select Set Report Options from it.

3. Select the Show drillthrough links on Number cells checkbox, then click OK.

The number fields in your report will turn into links.

4. Click on a drill-down link to see a data grid that shows all of the available details for that value.

5. To add or remove columns from the grid, click on the down arrow on the right side of any column and select the
Columns sub-menu. From there you can select which columns you want to appear. You can also sort by ascending
or descending values for any column through this menu.

You now have drill-down links for numeric, non-calculated members.
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Displaying Data in a Dashboard

Dashboard Designer enables you to create dashboards that provide users with immediate access to business-related
information they need. Using Dashboard Designer you can customize dashboards to address the needs of different
types of users. For example, your sales staff may want see current leads, while your support staff may want to see a list
of open issues. You can create dashboard pages that address the needs of both user groups.

Creating a dashboard is as simple as selecting a layout, theme, and the content you want to display. This content can
include reports, charts, data tables, URLs, and even interactive Pentaho Analyzer reports. Dashboard Designer also
provides you with the ability to add dynamic filter controls making it easy for dashboard consumers to filter the entire
contents of their dashboard using a simple pick list

The Dashboard Designer allows you to display the following content types in your dashboard:

• Chart — When selected, opens the Chart Designer that allows you to create bar, line, area, pie, and dial charts for
display in your dashboard.

• Data Table — When selected, allows you to display database-related content in tabular format.
• File — When selected, opens a browser window that allows you to locate a file (.xaction or .prpt) that contains the

content, usually a report or chart, you want to display in your dashboard.
• URL — When selected, opens a dialog box that allows you to enter the URL of the Web site you want to display in

your dashboard.

To display the content types in the Pentaho User Console, click  (Insert) in one of the panels in the dashboard.

If you are displaying a chart or data table you must first connect to the data source that contains data you want
displayed.

Creating a New Dashboard
You must be logged on to the Pentaho User Console. Follow the instructions below to create a new dashboard:

1. In the Pentaho User Console quick launch bar, click New Dashboard. Alternatively, you can click File > New >

Dashboard or click  (New Dashboard) in the tool bar. The New Dashboard page appears.

2. In the edit pane (lower portion of the page), click Properties, and enter a title for your dashboard page in the Page
Title text box.
The name you entered appears on the top left corner of the dashboard. This name helps you identify the page if you
want to edit, copy, or delete it later.

3. Click Templates to select a dashboard layout.
A blank dashboard with the layout you selected appears.

4. Click Theme to select a theme for your dashboard.
The theme you selected is applied to your dashboard.

Working with the Chart Designer

The Chart Designer allows you to create bar, pie, line, dial, and area charts that can be added to a dashboard. Below
are the general steps associated with creating a chart:

1. Select a data source.
2. Build a query.
3. Set the data definitions: values, series, category.
4. Select a chart type and theme.
5. Enter labels for the chart title, and x,y axes.
6. If applicable, adjust scaling and label rotation.
7. Place your chart in the dashboard.
8. Save your dashboard.

If you are new to charting, here are some minimal guidelines that may help you determine what type of chart is best
suited for the data you want to present in your dashboard:
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Bar Charts

If you want to compare items during a specific time period, consider using a bar chart. Key words to think about when
creating a bar chart are compare or rank. For example if you want to compare items sold to show which one made
the most profit, you might create a bar chart that ranks the products from the lowest to highest profit. The bar's length
determines its ranking; the label identifies the item. Bar chart data can be presented horizontally or vertically depending
on your requirements.

Pie Charts

If you are comparing parts of a whole, consider using a pie chart. Key words associated with charts include, portion,
share, and percentage. If for example, you want to demonstrate the proportion of the company's budget spent on health
insurance, use a pie chart. To make the chart easier to read limit the number of slices to five. Pie charts can also be
exploded, which means certain slices are pulled away from the remainder of the chart for emphasis.

Line Charts

Line charts are useful for showing changes over time. Key words associated with data that is best suited for a line chart
are trend, growth, and decline. If, for example, you want to show how product sales have changed over five years, use
a line chart. The slope of the line helps users quickly identify the direction of the trend.

Dial Charts

Dial charts are often associated with Key Performance Indicators (KPIs). Dial charts are circular and contain a scale,
a needle, and one or more a dial sectors. The dial sector is used to identify a specified area on a dial chart using
a particular color. For example, you could have a dial plotting inventory with a minimum dial value of 10000 and a
maximum dial value of 50000. There could be a red dial sector for the region between 2000 and 4000 indicating that if
the needle is in this area, there is a danger of a supply inventory shortage.
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Area Charts

Area charts can be used to show a comparison of the same thing during different points in time. Area charts are
not designed to provide exact data but they do give users visual clues of the relative sizes of the items they are
representing.

Adding Data to Your Chart

Before you can start creating a chart you must select a data source that contains the data you want to use. You must
then define the data that will be displayed in the chart.

Note:  If you are unsure what chart type is best for displaying your data, see Choosing the Correct Chart Type
for more information.

Follow the instructions below to add data to your chart:

1. In the Dashboard, choose a dashboard panel and click  (Insert) and select Chart.
The Select a Data Source dialog box appears.

2. Select the data source from the list of available choices. The data source contains the content you want to display in
your chart.
The Query Editor appears.

3. The Query Editor allows you to retrieve dynamic data from a database for display in a chart. Defining your query is
the first step in ensuring that the correct data is selected. In the Query Editor, click (+) next to a category name to
display its associated table columns.

4. Click the small yellow arrow to place the column name under Selected Columns. In the example below, the
Customernumber column has been selected and moved under Selected Columns. Notice that the column names
appear under Selected Columns. Continue adding columns as needed.
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5. Now add the Conditions; these are your constraints that filter what you are selecting. You can add multiple
conditions. In the example below, the search is limited to customer numbers.

Under Combine, you can select your constraint (and, or, and not, or not) from the drop-down list. Under
Comparisons you can click the drop-down list to display options for comparisons, =, <, >, and so on; (for example,
where the customer number is equal to 144 or 145). You can also select an aggregation type from the drop-down list
for table columns that contain numeric data. The table below contains a definition for each aggregate type:

Aggregate Type Description
SUM Sums a column's values
COUNT Counts a column's values
AVG Averages a column's values
MIN Selects the minimum column value
MAX Selects the maximum column value

Note:  For information about adding parameters in the Query Editor, see Assigning Parameters in the MQL
Query Editor.

Note:  Click Preview at any time to view the data associated with your query.

6. Add the columns that you want to Order By. The ordering of the selected data is accomplished by one or more
columns in a table. For example, you can sort the data by customer name and address.

7. Click OK in the Query Editor when you are done.
The Chart Designer appears.
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8. Under Data, click the drop-down arrow to display and select the table columns.

Data Definition Description
Values The value is always numeric. The value determines the

height of columns in a bar chart and the height of lines in
a line chart. In area charts, the y-axis values determine
the heights of the points.

Series Series show up as the individual columns on a bar chart
and as individual lines in a line chart. Area charts display
each series as a point.

Category Categories are displayed as bars or groups of bars on
the y-axis (vertical axis). In line charts, categories are
usually associated with time periods. In area charts, the
x-axis displays the category labels.

A preview of the chart appears in a box in the upper-right corner of the Chart Designer as you select your options.

9. Under Chart Type, click on a chart type to select it.

Note:  By default, charts display in "animated" Flash mode. You can turn animation off by disabling the
Animated check box in the Chart Designer. Animated charts bring focus to important aspects of your data.
For example, animation allows you to bring out a data point if it reaches a critical value, such as high or low
sales numbers.

If you selected a pie or dial chart, see Working with Pie Charts or Working with Dial Charts, respectively.

10.Under Theme, select a theme from the list.
The theme is applied to your chart.

11.Enter the labels for the Chart Title, X Axis Title (horizontal axis), and Y Axis Title (vertical axis).
Entries are displayed in the chart preview.
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12.Click Apply to see the chart preview.

13.Click OK display your chart in the dashboard panel.

Working with Pie Charts

A pie chart gives dashboard consumers an immediate visual clue of the relative sizes of the shares of a whole.
Categories are represented by individual slices. The size of the slice in a pie chart is determined by the value.

You can animate a pie chart if you want its pieces to be exploded, which means that the individual slices of the pie can
be pulled away from the rest of the pie.
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To animate a pie, enable Animated check box in the Chart Designer.

Working with Dial Charts

For dial charts to display correctly, you must enter values for your range and the chart title. In the example below, the
dial chart preview is displaying ranges associated with sales. Notice that each dial sector is represented by a color, red,
yellow, or green. The needle is positioned in the 220796.48 range, indicating that total orders, while not stellar, are not
near the danger zone indicated by the red sector in the dial.

Changing Dial Sector Colors

You can change the color of a dial sector by clicking the small down arrow in the color boxes associated with Range.
Select a color from the palette so that you can preview it on your dial chart. Click Apply to preview your dial chart. Click
OK to place your dial chart into the dashboard.
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Correcting Scaling Issues

Use the scaling feature in instances where numeric values in a chart are so long that they affect the display.

1. Preview your chart in the Chart Designer.

2. Under Scale, click to display the drop-down list of scaling options. In the example below, the scaling option used is
"1000." Notice the change in the display of numeric values when scaling is applied. Users of the chart can see actual
values when they hover over the bars in the chart.

3. Click OK to display the chart in the dashboard.

Note:  The scaling feature is available for all chart types except pie.

Rotating Chart Axis Labels

If your chart axis labels become unreadable because they are too long, Label Rotation may correct the problem.

1. In the Chart Designer, display your chart.

2. Under Label Rotation, select Diagonal or Vertical and click Apply.
The labels display with the rotation you set.

3. Click OK to display the chart in the dashboard panel.

Editing a Chart

Follow the instructions below to edit a chart.

1. In the Dashboard Designer, select the panel that is displaying the chart you want to edit.

2.
In the upper right corner of the panel click (Edit)
The Chart Designer appears.

3. Click Edit Query.
The Query Editor opens.

4. Edit the query as needed and click OK.
The Chart Designer appears.

5. Select the appropriate data definitions to build the chart.

6. If applicable, change the chart type and theme and click Apply to see a preview of the edited chart.

7. Click OK to display the chart in the dashboard.

Adding a Data Table to a Dashboard

The Data Table feature allows you to display a tabular representation of a database query in a dashboard. It also allows
you and consumers of the dashboard to manipulate the data in the data table, while in the dashboard. For example,
users can resize, sort, and change the order of columns. Follow the instructions below to add a data table to your
dashboard.

1. Select a panel in the Dashboard Designer.

2. Click  (Insert) and select Data Table.
The Select a Data Source dialog box appears.

3. Select a data source from the list of available data sources and click OK.
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Note:  The data sources in the list are defined by an administrator.

The Query Editor opens.

4. Begin building your query. Click (+) next to the category name to display its associated table columns. When the
column names appear, click to select the column that contains the data you want displayed in your data table.

5. Click the small yellow arrow to place the column name under Selected Columns.

6. Now add the Conditions; these are your constraints that filter what you are selecting. You can add multiple
conditions.

Under Combine, you can select your constraint (and, or, and not, or not) from the drop-down list. Under
Comparisons you can click the drop-down list to display options for comparisons, =, <, >, and so on; (for example,
where the customer number is equal to 144 or 145). You can also select an aggregation type from the drop-down list
for table columns that contain numeric data. The table below contains a definition for each aggregate type:

Aggregate Type Description
SUM Sums a column's values
COUNT Counts a column's values
AVG Averages a column's values
MIN Selects the minimum column value
MAX Selects the maximum column value

Note:  Click Preview at any time to view the data associated with your query.

7. Add the columns that you want to Order By. The ordering of the selected data is accomplished by one or more
columns in a table. For example, you can sort the data by customer name and address.

8. Click OK in the Query Editor when you are done.
The Data Table appears in the dashboard panel.

Updating the Data Table Display

You can edit the data table display directly in the dashboard panel.

Sorting Column Data

To change the sort order data under a column, click the drop-down arrow in the header and choose Sort Ascending or
Sort Descending. You can also hide one or more columns by disabling the appropriate check boxes next to the column
names.

Adjusting Column Width

You can adjust the width of a column by clicking the right border of the column header and dragging it to the right or left.
Release the mouse button when you are done.
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Moving Columns

To move the placement of a column, click and drag the column it to the appropriate location in the Data Table as shown
in the example below:

Paginating

The pagination feature allows you to page through a large number of records.

Displaying a Report Designer (.prpt) File in the Dashboard

Follow the instructions below to display a report created in Report Designer and in a dashboard.

1. Select a panel in the Dashboard Designer.

2. Click  (Insert) and select File.
A browser window opens.

3. Locate the appropriate report file. Report Designer files have a .prpt extension.

4. Click Select to place the report inside the dashboard panel.

Pagination control arrows at the top of a report allows you to scroll through long reports. Notice that the report file
name, NewReport.prpt, appears under Content: in the dashboard edit pane in the sample below. This sample report
contains parameters, (Additional Title-Text, Output Type), that do not have default values. You can enter values
manually and link them to a dashboard filter in the text boxes under Source. When the report renders again, the
parameter value(s) you entered are included in the report.
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Important:  If you select a Report Designer file to place in a dashboard, but do not supply values for required
parameters, the report will show up blank.

Displaying an .xaction File in the Dashboard

Follow the instructions below to display the contents of an .xaction file in a dashboard.

Note:  Generally, .xaction files are provided to you by an administrator. An .xaction file may contain a report, a
chart, or other type of content.

1. Select a panel in the Dashboard Designer.

2. Click  (Insert) and select File.
A browser window opens.

3. Locate the appropriate .xaction file.

4. Click Select to place the contents of the file inside the dashboard panel.

Notice that the file name, Sales Year/Year, appears under Content: in the dashboard edit pane of the sample below.
This sample chart contains parameters, (screen_res, Region), and default values (large, NA).
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Displaying a Web site in a Dashboard

Follow the instructions below to display contents of a Web site in a dashboard panel. You may need administrator
privileges to display a Web site content in a dashboard.

1. Select a panel in the Dashboard Designer.

2. Click  (Insert) and select URL.
The Enter Web site dialog box appears.

3. Enter the Web site URL in the text box and click OK.

In the example below, a search parameter has been added to the URL.

When the parameter displays in the edit pane of the dashboard, you can enter a value for the parameter in the text
box next to the parameter name.

4.
If applicable, click (Edit) to make changes.

5. Save your dashboard when you are done.

Working with Parameters
If you are placing an .xaction or .prpt inside a dashboard panel, it is possible that the author of the .xaction or report,
defined meaningful parameters for the content. If previously defined, the parameters and their associated default
values, appear under Parameters in the edit pane of the dashboard. In the example below, when the chart initially
rendered, it displayed a parameter called, "chart_type" with a default value called, "bar." A user can change the value of
the parameter to see the content rendered as a pie, line, or area chart.
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Parameter names are "hard-coded," which means they cannot be changed. Neither can you change the number of
parameters associated with an .xaction or .prpt file. When you create a chart using the Chart Designer, embed a URL
into a dashboard, or create a data table, you can change both the name and value of a parameter.

Assigning Parameters in the Query Editor

If you have set filter controls/parameters in your dashboard, you can edit them in the Query Editor. Dashboard Designer
recognizes when you have set filter controls and displays them in a drop-down list. For example, suppose you have a
filter control called "REGION," you can set the default value for your constraint to "North." When the chart renders, it
displays data for the North region specifically.

If you haven't set filter controls in the dashboard, you can add them manually in the Query Editor. In the Value field type
the name of the filter control inside curly braces, as in {Name_your_filter}. In the example below, the designer created
a filter control called, {letter}; the default value for the filter control is, "S." When the chart is rendered it displays data
associated with customers whose last names start with the letter "S."

Suppose the designer chooses not to display parameters and wants to limit the data to names ending with "S,"
exclusively? In this instance, he or she would not include the curly braces around the letter "S," and the Default value is
disabled.



Pentaho BI Suite Official Documentation | Displaying Data in a Dashboard | 29

Working with Filters
Filters allow you to display a subset of data based on the dashboard user's point of view. For example, the dashboard
user's point of view of Region may be "East;" his or her point of view of Time may be, "Fourth Quarter." Pentaho
Dashboards allows you to designate a point of view based on the filters in your source data. Follow the instructions
below to add filters to your dashboard:

1. In the dashboard page, under Objects, select Filters.
The Filter Editor appears on the right. No filters are listed if this is the first time you are assigning filters.

2. To display a filter toolbar to users of the dashboard, enable Show Filter Toolbar.
A placeholder for the filter toolbar appears at the top of the dashboard.

3.
Click  (Add) to start adding filters.
The Filter Control dialog box appears.

4. In the Filter Control dialog box, type a display name for the control label. For example, "Region."

5. Enable Display Name as Control Label if you want users to see the display name in the filter toolbar.

6. Select your control type. Control types define how your filter values are selected; for example, in a drop down list,
radio button

The table below contains information about each control type.

Control Type Description
Drop Down Users select filter values from a drop-down list. You can

provide static...
List Users select filter values from a scrolling list.
Radio button Users click radio buttons to select filter values.
Checkbox Users click checkboxes to select filter values.
Button User click buttons to select filter values.
Text Field Users enter a value into a text field.
Date Picker Users examine data based on calendar date.

7. If you plan to provide hard-coded names and values for your dashboard users, see Creating a Static List of Filters. If
you plan to provide a dynamic list of filters based on a SQL query, see Creating a SQL List of Filters.

Creating a Static List of Options

When you create a static list, you define a static list of options to present to the dashboard user. Each option consists of
a display name that appears in a drop-down list in the filter toolbar as shown in the sample on the right.

Follow the instructions below to create a static list:

1. In the Filter Properties dialog box, under Data Type, select Static List.

2.
Click  (Add).
The List Value dialog box appears.
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3. In the List Value dialog box, enter the label and a value for the first option in the list. The label is the option that is
visible to dashboard users; the value is an internal name.

4. When you are done adding options, click Close.

5. Click OK to exit the Filter Properties dialog box.
The filter options are displayed to the dashboard user. In the sample screen capture above, North America is the
first option on the list.

Creating a SQL List

When you create an SQL List, you are using an SQL query to dynamically retrieve a list of display names and
corresponding values directly from a relational database.

Note:  You must have administrative permission to create SQL-based filters.

Follow the instructions below to create an SQL List:

1. In the Filter Properties dialog box, enter a Name for your filter.

2. Enable the Display Name as Control Label, if appropriate.

3. Under Type, select SQL List.

4. Select the data source (Connection) that contains the content you need to set options from the drop-down list.

5. Click ____________ to display the Query input text box.

6. Type the SQL query in the area provided for you.

7. Click Test to ensure that your SQL query is displaying the correct values.

8. Adjust your SQL query as needed and click OK.
The list of values appear in the filter toolbar in the dashboard.

Creating a Metadata List

When you create a Metadata List, you are defining a query to retrieve a list of display names and corresponding values
from a metadata data source provided by your administrator.

1. In the Filter Properties dialog box, enter a Name for your filter.

2. Under Data Type, select Metadata List.

3. Click Select to choose the data source that contains the content you need to set options from the drop-down list and
click OK.
The Query Editor opens.

4. In the Query Editor, build a query to select either a single column (that represents both a name and a value), or two
columns representing the display names and corresponding values.

Note:  If a single column query is defined the values of that column will be used for both the display names
and the values.
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5. Click OK to exit the Query Editor.
Your options under Selected Items in the Filter Properties dialog box.

6. Click OK to exit the Filter Properties dialog box and save your dashboard.

Editing Filters

You can edit filters as needed. Follow the instructions below to edit filters:

1. In the dashboard page, select an existing dashboard.

2. Under Objects, click Filters to display the filters associated with the dashboard you selected.

3.
Select the filter you want to edit and click .
The Filter Properties dialog box appears.

4. Make your changes as needed and click OK to update the filter-related options in the dashboard.

Setting the Refresh Interval

The content in your dashboard may need to be refreshed periodically if users are examining real-time data. You can set
refresh intervals for individual panels on your dashboard or for the entire dashboard.

To set the refresh interval for individual panels in the dashboard, select the panel that contains the content you want
refreshed. Under Refresh Interval (sec) enter the interval time in seconds and click Apply.

a

If you want the entire dashboard to refresh, click the Properties tab in the dashboard and set your refresh interval.

Linking Analyzer Filters to Dashboard Parameters

This process only applies to dashboards that include parameterized Analyzer reports. You must have an Analyzer
report with a query parameter in it in order to proceed.

The instructions below explain how to link a query parameter from an Analyzer report to a dashboard in Dashboard
Designer.

1. In Analyzer, select a parameter in your report to which you want to link; then, right-click and choose Filter.

In the example below, data will be filtered by Territory.
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2. In the Filter dialog box, enter a name for the parameter in the Parameter Name text box and click the check box to
enable it.

3. Select the values you want associated with the parameter. Use the arrows to add values to the box on the right.

4. Click OK to exit the Filter dialog box.

5. Save your Analyzer report.

In the upper left corner of the report, you can see that a filter is in use. Click  (Edit) to edit your filter; click  to
delete the filter.
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6. Create a dashboard and drag the Analyzer report into a panel.

The name of the parameter appears in the lower portion of the dashboard under Parameters.

7. Add a filter to the dashboard based on the parameter you created in your Analyzer report.
The filter appears in the dashboard.

Saving Your Dashboard
Follow the instructions below to save your dashboard:

1. In the Pentaho User Console toolbar, click  (Save) to open the Save dialog box.

2. In the File Name text box, type a file name for your dashboard.

3. Enter the path to the location where you want to save your dashboard. Alternatively, use the up/down arrows or click
Browse to locate the solution (content files) directory in which you will save your dashboard.

4. Click Save. See Editing Your Dashboard.

Editing Your Dashboard
Follow the instructions below to edit an existing dashboard:

1. In the lower left corner of the Pentaho User Console, (under Files), select an existing dashboard file.
The dashboard panels and their related content appear.

2.
Click (Edit) in the upper-right corner of the dashboard panel you want to edit.

Note:  Some content such as .xaction and .prpt files cannot be edited directly in the dashboard. In such

instances,  (Edit) is disabled.

3. Make your changes as needed.

4. In the toolbar, click (Save As) to open the Save As dialog box.

5. In the File Name text box, type a file name for your dashboard. Alternatively, use the up/down arrows or click
Browse to locate the solution (content files) directory in which you will save your dashboard.

6. Click Save.
The name of your dashboard file appears in the list under Files in the lower left portion of the Pentaho User
Console.

Adding Content to a Dashboard Using Drag-and-Drop
Follow the instructions below to add an existing chart, table, or file to your dashboard panels using the drag-and-drop
feature.

1. Create a new dashboard. See Creating a New Dashboard for specific instructions.

2. In the left pane of the Pentaho User Console, under Files, locate to the content (chart, table, or file) you want added
to your dashboard.
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3. Click and drag the content into a blank panel on your dashboard. You will see the "title" of the content as you move it
around the dashboard. Notice that the title background is red; it turns green when you find a panel where the content
can be dropped.

Repeat steps 2 and 3 until your dashboard contains all the content you want to display. To swap content from one
panel to another, click the title bar of the panel that contains the content you want moved and drag it over the panel
you want swapped. You will see the swap icon as you are moving the content.

If you are working with an existing dashboard, you can perform steps 2 and 3 steps; however, a warning message
appears when you try to place content in a panel that already contains content. The new content will override the
existing content.

4. Save your dashboard.

Adjusting Whitespace in Dashboard Panels
Sometimes you must adjust the whitespace in dashboard panels so that the content appears correctly. Follow the
instructions below to adjust whitespace.

1. Open an existing dashboard.

2. In the lower pane, click the Properties tab.

3. Click Resize Layout.
The whitespace between the dashboard panels turns blue.

4. Adjust the panel size by clicking and holding the left mouse button down as you move the blue lines (whitespace)
around. Release the mouse button when you are satisfied with the positioning of the panel.

5. Click Close in the lower right corner of the dashboard to exit resize layout mode.

6. Examine the dashboard contents to make sure they are placed correctly. You can return to the resize layout mode if
you need to make additional changes.

7. Save your dashboard.
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Linking to Content in a Dashboard

The content linking features in dashboards allow you to link to content in one dashboard panel to another dashboard
panel as long as parameters have been assigned. You can use content linking if your dashboard panel contains a data
table, chart, .xaction, or file.

Note:  Content linking is not available for dashboard panels that contain URL-based content.

Linking Charts and Data Tables
Below are general instructions for linking charts and data tables in a dashboard. This is just an example. You must
adjust the instructions when working with your own data.

1. Create a simple dashboard that contains two charts, a data table. At this point, none of the content has been linked
and you have a "static" dashboard.

Notice the pie chart in the example above. You want report consumers to click on a slice (NA, APAC, Japan, EMEA)
and have the data table on the right update with the values associated with that slice specifically. For example, if a
report consumer clicks on the EMEA slice, the data table will display values associated with EMEA only. To get the
correct filter display, you must first create a parameterized query that drives the content in the data table.

2. Add a condition to the query so that you can filter the data in your data table. In the example below, the parameter/
filter is {TERRITORY} and the default value is NA (North America).

In the Pentaho User Console, when you click on the data table, you can see that you have an available parameter
called TERRITORY.
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3. Edit your data chart to enable linking. In the Chart Designer, click Enable content linking. To display a default
value when your chart renders for the first time, enter a value in the Series Default Value text box.

When the report renders, the data table updates each time a user clicks a slice.
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Scheduling Reports

The Pentaho User Console has the ability to run reports at specified intervals, even if user input is required to properly
execute the report. The sections that follow explain how to set up and configure private schedules. Private schedules
are ad hoc, non-subscription schedules; subscription schedules, also referred to as public schedules are set up by an
administrator. You must have proper permissions to set up a private schedule.

For more information about schedules, see the demo, Scheduling, Subscription and Distribution, on the Pentaho Pre-
Sales Sandbox.

Scheduling a Report
You can configure the Pentaho BI Server to run reports at regular intervals, or on certain dates and times. Follow the
instructions below to create a private schedule.

1. In the left pane, navigate to the location of your report. It should appear in the lower left list when you've selected the
proper directory.

2. Right-click the report you want to schedule, then click Schedule in the context menu.

The New Schedule window appears.

3. Type in a name to identify the schedule by in the Name field, and a group name (for groups of schedules) in the
Group field. Optionally you can also enter a description of the schedule in the Description field.

4. Select an interval from the Recurrence drop-down box. If you would like to enter a custom interval, select Cron and
consult the Quartz reference to learn the Quartz syntax.

5. Adjust the interval settings accordingly; these settings should be self-explanatory.

6. Click OK to complete the schedule.

The report is scheduled to execute at the interval you specified. It will also be listed in My Workspace.

Quartz Cron Attributes

The Quartz cron engine supports a seven-attribute time declaration with many possible values. The number format is
the same for every expression, even if the values are different -- it must be listed as seconds, minutes, hours, day of
month, month, day of week, then the year. A space separates each attribute.

Possible values for each attribute should be mostly obvious -- 0 to 59 for seconds and minutes, 0 to 23 for hours, 1
to 31 for days, 1 to 12 for months, 1 to 7 for day of week, and a four-digit year. Alternatively you can use three-letter
values for the day of week (MON, TUE, WED, THU, FRI, SAT, SUN), and three-letter values for the month (JAN, FEB,
MAR, APR, MAY, JUN, JUL, AUG, SEP, OCT, NOV, DEC).

An asterisk (*) indicates all values, so an asterisk in the minute field would mean that the report runs once every minute.
You can specify a range of values with the - (dash) operator, and you can specify multiple individual values with a
comma. If you need to excuse a value in the day of month and day of week field from a cron job, you can use the
question mark (?) character to indicate that this value doesn't matter. If you need to split values, you can do so with the
slash (/) character -- this operator literally means "every," so */15 would mean "Every 15." In the day of month field, you
can use the # character to indicate a certain instance of a day of the month, for instance the second Friday of the month
would be 6#2. Lastly, you can use a capital L in the day of month and day of week field to indicate "Last," as in the last
day of the week. A capital C in either of these fields means "Calendar," and combined with a number means that the
report should execute a the interval indicated by the C number according to the loaded calendar. A capital W in the day
of month attribute means "Weekday," which only encompasses Monday through Friday. Most of these values can be
combined to create unusual cron schedules.

Attribute Conditionals and Operators
Seconds , - * /
Minutes , - * /
Hours , - * /
Day of month , - * ? / L W C
Month , - * /
Day of week , - * ? / L C #
Year , - * /
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Execute a report at 10:15 AM on every last friday of every month during the years 2008, 2009, and
2010:

0 15 10 ? * 6L 2008-2010

Deactivating Schedules
Once you've scheduled a report, you can easily delete the schedule without deleting the report. You must have
administrative privileges to delete a schedule.

Note:  To reliably delete a schedule, suspend the schedule first then delete it from your workspace. After the
delete process completes, you may restart the schedule.

1. Click the My Workspace button, which is the second one in from the right side of the toolbar.

2. Click the triangle next to the Waiting section to see a list of scheduled reports.

3. Click Cancel next to the schedules you'd like to delete.

The previously scheduled report will no longer run at the specified interval.
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Troubleshooting

Below are problems that have been discovered by other Pentaho User Console users and testers, and solutions for
addressing them.

Internet Explorer 8 can't preview CSV/PDF/XLS ad hoc report content

Internet Explorer 8 has extra security features that prevent users from downloading content files generated by the ad
hoc reporting interface. In order to work around this, you must force IE8 to recognize the BI Server host as an intranet
zone.

To do this, go to the Tools menu in Internet Explorer, then select Internet Options. In the ensuing options screen,
click the Security tab, then the Local Intranet icon. Click the Sites button. In the dialogue the follows, deselect the
Automatically detect intranet network option, then click OK to close this window, then OK again to close the Internet
Options window.
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